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1.   Introduction 
 
1.1  What WinPHOTON is and does 

 
 WinPHOTON is a post-processor used to visualize results of calculations produced 

by PHOENICS. WinPHOTON possesses all the functionality of its predecessor, PHOTON; 
but it differs  in that it exploits the graphic possibilities offered by the operating system 
(Windows, Xwindow, LINUX/UNIX), thus providing a more modern interface for users. 

  
 The reader of this document is presumed to be familiar with the main relevant 

features of PHOTON, namely that: 

 PHOENICS places the results of its calculation in a file called (by default) phi; but 
other (4-character) names may be used. 

 If a body-fitted grid was used, it places the cell-corner co-ordinates in a file called 
(by default) xyz, but other 4-character names may be used. 

 PHOENICS places information about the boundary-condition-setting patches 
which it has used in a file called PATGEO. 

 PHOTON, when first started, looks for a file called u; and, if it exists, obeys the 
commands which it contains. 

 If PHOTON finds in u the command: 'use filename', it looks for a file called 
'filename' and executes the commands contained in it. 

 
The commands in question include: 

 gr  , to show the grid 

 con , to show contours 

 vec , to show vectors 

 sur , to show iso-surfaces. 
 
There are, of course, qualifications for each command, for example: 

 on which plane (ix = ? , iy = ?, iz = ?) are the images to be displayed? [PHOTON 
cannot select arbitrary planes]. 

 should contours be represented by lines or by colour gradations? 

 what should be the size of the vectors? 

 what should be the value of which the iso-surface should be drawn? 
 
While users work with dialog windows, internally the program executes the usual 

array of PHOTON commands which, generated in sequence, provide the needed result.  
With just a few mouse clicks, users are able to produce graphic images of calculation results. 

 
Although WinPHOTON differs visually from PHOTON, it embodies many of its 

features: 

 Commands may be entered manually to create drawings and set parameters, the 
commands being almost the same as for PHOTON; 

 When WinPHOTON is run, it records commands entered during the session into a 
file called PHOLOG.  This file is written in  USE-file format, which can be read by 
WinPHOTON to recreate the session at a later date. 

 WinPHOTON is integrated with AUTOPLOT into a single program; 
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1.2     Features of WinPHOTON 
 

Features of WinPHOTON can be classified as: 

 Interface features; 

 Function features; 

 Settings features. 
 
 
Interface features include: 

 Separate windows for entering information and for drawing. The program draws 
figures in the main window; but users enter commands and see program 
messages in a dialog window, namely the Command Console; 

 WinPHOTON contains a standard menu interface and a set of dialog windows; 

 Help and Tutorial use the Internet browser installed in the default operating 
system. 

 
WinPHOTON has many function features not possessed by PHOTON including the 

ability to allow users to: 

 save, in a file, a drawn Figure as a set of commands; 

 edit the USE-file while running the program; 

 use any fonts installed in the operating system to create TEXT objects; 

 change the order of object drawing; 

 change the number of colours in the palette from 16 to 256 to draw CONTOUR 
objects and smooth images; 

 edit parameters for almost all types of objects (GRID, TEXT, CONTOUR and 
others); 

 delete any object from a list, (not only the last object as was the case in PHOTON); 

 show boundaries of cut-cell control volumes if PARSOL is used for calculations; 

 see results of calculations as graphical images and as tables of values for each 
field variable; 

 create new macro-variables, assign values to them, use formulae for determination 
and apply them in a processing package; 

 create a new field variable and use formulae for its determination or use calculated 
field variables and macro-variables. After creating new field variables, users can 
apply them to all methods of processing as for the usual variables calculated from 
PHI files; 

 view the sequence of results for transient cases without editing the USE-file in 
animated mode and as a slide show. 

 
WinPHOTON has new settings features for the user interface so that users can: 

 set the colours of the background of drawing area, the default font, main lines and 
background of outside area; 

 set the sequence of object drawing for various types: GRID, CONTOUR, TEXT 
etc. 
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1.3  Parameters of the environment 
 

WinPHOTON is part of PHOENICS.  It should be installed on the same hard-drive 
partition as other PHOENICS modules; otherwise, it will not work. 

 
For WinPHOTON to work successfully, it is necessary to check files: 

/phoenics/d_allpro/cham.ini and /phoenics/d_photon/coldat.  

 

The file /phoenics/d_allpro/cham.ini should contain the section [F-

array]; and this section should contain line PHOTON = 32768.  This is the recommended 

value of F-array size, although users may change it.  However, WinPHOTON will allocate 
memory dynamically as it reads PHI-data; therefore this value influences the working of 
AUTOPLOT only. 

 

The file /phoenics/d_photon/phocon must contain the line: 
50;  pbcl.dat ;PARSOL data to be read; 98; 2; 1;  80 

This is necessary for calculations involving PARSOL. 
 

WinPHOTON saves all executed commands into a file called pholog, located in the 

current working directory.  These are: commands entered by users, commands from USE-file 
and commands generated by dialog windows.  

 

AUTOPLOT saves all executed commands into the file autlog, located in the current 

working directory. 
 
 

1.4  On-line Help and Tutorial 
 
PHOTON has a Help facility which users can access from the main menu or from the 

Command Console window.  Typing ‘?’ in the Command Console brings up help information 
in an Explorer window. 

 
WinPHOTON has a Tutorial which users can start from the main menu.  It describes 

what users must do to learn the main features of the program. 
 
 

1.5  About this Guide 
 
This document contains a description of the User interface and information about the 

commands for WinPHOTON.  More detailed information about WinPHOTON commands and 
AUTOPLOT can be found in the Help facility. 

 
This User Manual consists of an Introduction and three further chapters.  Chapter 2 

contains a general description of the program interface, the main window and the Command 
Console. Chapter 3 describes how to use WinPHOTON; and Chapter 4 describes how to use 
AUTOPLOT. 
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2.   General View 

 
This chapter contains information on the general structure of  WinPHOTON. 
 

2.1   Main Window and Main Menu 
 
A view of the main WinPHOTON window, while running a case, is shown in Fig 2.1.  

 

 
Figure 2.1 

 
The main window contains the menu at the top, the status line at the bottom, the 

drawing area in the centre and the Command Console window (see 2.1.2). 
 
The status line has three sections. Users can see whether the program is ready to 

have data entered in first section (Status). The second section contains information as to 
which part of the program is running at the current time (Section). The third section is seldom 
used but could, for example, indicate the cursor position. 
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A view of the main AUTOPLOT window, while running a case, is shown in Figure 2.2. 

 

 
Figure 2.2 

 
2.1.1 Menu of WinPHOTON 

The WinPHOTON menu has the following structure:  
 
     File Submenu  

Submenus Description Comments 

Open PHI/XYZ File 
Opens dialog to select file type, set scales and activate 
opening mode (with Extrapolation or without). 

See 3.1.1 

Open Use file Opens dialog to select USE-file. See 3.1.2 

Open PATGEO file Opens dialog to select file PATGEO. See 3.1.3 

Save Windows As 

Opens the standard window of the operating system to 
enter name of files to save graphic information. Users can 
save graphic files in two formats – GIF or PCX. The 
program saves graphic information of the drawing area 
from an internal buffer (not from the screen) therefore 
saved information does not depend on the Command 
Console. Users will not see Command Console on the 
saved Figure. Background colour is determined by 

parameter PCX_Background from section [FTN386] of 

file /phoenics/ d_allpro/cham.ini. 
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Print Window 

Opens standard operating system window to print the 
graphical view from drawing area. Background colour is 

determined by parameter PCX_Background from section 

[FTN386] of file /phoenics/ d_allpro/cham.ini. 

 

Exit 
If users select this item, the program will terminate 
immediately, without finishing the drawing of a complex 
Figure. 

 

 
     View Submenu  

Submenus Description Comments 

Show Console 
Useful for showing and hiding the Command Console 
window; it is selected by users. 

 

Show command… 

Contains submenus: Variables, Grids, Vectors, Contours, 
Surfaces, Stream, Text, Blocks, and Geometry.  Selection 

of any of them generates the command SHOW (for 

example, SHOW VARIABLE). Users will see the result of 

command execution in the Command Console window. 

 

View direction 
Opens View Direction dialog, enabling users to change 
UP direction, angles of axes in space, zoom and other. 

See 3.3.1 

All messages 
Opens window All messages, which shows to the users 
all messages from window Command Console. 

 

 
    Window All messages shown on Figure 2.3 
 

 
Figure 2.3 
 
     Variables Submenu  

Submenus Description Comments 

PHI Variables 
Opens window Select Variables containing list of field 
variables.  

See 3.4.2 

Macro Variables 
Opens window Macro Variables containing list of macro-
variables. 

See 3.4.1 

Look of Variables 
Opens window Select Variables to select field variable to 
see calculated values as table. 

See 3.4.3 
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     Draw Submenu  
 

Submenus Description Comments 

Clear Generates command CLEAR  

Redraw All Generates command REDRAW  

Grids Opens window containing list of GRID objects.  See 3.2.1 

Contour Opens window containing list of CONTOUR objects. See 3.2.2 

Vector Opens window containing list of VECTOR objects. See 3.2.3 

Surface Opens window containing list of SURFACE objects. See 3.2.4 

Stream Line Opens window containing list of STREAM LINE objects. See 3.2.5 

Text Opens window containing list of TEXT objects. See 3.2.6 

Save drawing 
Command 

Opens standard window of the operating system to enter 
names of files to save sets of commands and create 
GRIDS, VECTORS, CONTOURS and SURFACES 
created by users at the current time. 

 

Transience  Opens window to view results of transient cases  See 3.5 

 
     Settings Submenu  

Submenus Description Comments 

Set params Opens window to set some parameters. See 3.3.2 

Set colours Opens window to set colours of general elements. See 3.3.3 

Plotting order Opens window to set order of drawing objects on screen. See 3.3.4 

 
     Run Submenu to run AUTOPLOT. 
      
 Help Submenu  

Submenus Description Comments 

Contents Opens main page of Help in default html-browser.  

Tutorial Opens main page of Tutorial in default html-browser.  

About Opens window containing program version data.  

    
 

2.1.2 AUTOPLOT Menu 
The AUTOPLOT Menu is structured as follows: 
 
     File Submenu  

Submenus Description Comments 

Data files Opens dialog, which contains the list of opened files.  See 3.1.1 

Open use file Opens dialog to select of USE-file. See 3.1.2 

Save Windows As 

Opens standard window of the operating system to enter 
names of files to save graphic information. Users can 
save graphic files in two formats – GIF or PCX. The 
program saves graphic information off the drawing area 
from an internal buffer (not from screen) therefore saved 
information does not depend on placement of the 
Command Console. Users will not see the Command 
Console on the saved Figure.  

 

Exit 
If users select this item, the program will terminate 
immediately, without finishing the drawing of a complex 
Figure. 
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   View Submenu 

Submenus Description Comments 

Show Console 
Useful for showing or hiding the Command Console 
window. 

 

Show command… 

Contains submenus: Text, Keys, Groups and Files. 

Selection of any of them generates the command SHOW 

(for example, SHOW TEXT). Users will see the result of 

command execution in the Command Console window. 

 

All messages 
Opens window All messages, which shows users all 
messages from window Command Console. 

 

 
             Window All messages shown on Figure 2.4 

 
Figure 2.4 
 
   Command Submenu 

Submenus Description Comments 

Redraw Generates the command REDRAW  

Clear Generates the command CLEAR  

Datas 
Opens window containing the list of DATA objects for 
graphic drawing.  

See 4.2 

Texts Opens window containing the list of TEXT objects. See 4.3.1 

Levels Opens window containing the list of LEVEL objects. See 4.3.2 

 
   Settings Submenu 

Submenus Description Comments 

Set colours 
Opens window to set colours of general elements of main 
window. 

See 4.4.1 

Keep parameters 
Opens window to set types of objects which will be saved 

after execution of command CLEAR. 
See 4.4.2 

Scale Opens window to set parameters of command SCALE. See 4.4.3 

Grid Opens window to set parameters of command GRID. See 4.4.4 

 



The PHOTON User Guide 

10 The PHOTON User Guide 

   Run Submenu to run WINPHOTON. 
 
   Help Submenu 

Submenus Description Comments 

Contents 
Opens main page of AUTOPLOT Help in default html-
browser. 

 

About Opens window containing program version data.  

 
 

2.2  Command Console 
 
The general view of the window Command Console is shown in Figure 2.5 
 

 
Figure 2.5 
 
The field Last Message on top is for program messages. It provides information for 

users resulting from the last command entered, information about errors and so on. 
  
The field Commands contains the Run button and a box for entering commands.  The 

latter also provides a pull-down list to see previously-entered commands. The box has the 
Code Completion property. 
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3.    WinPHOTON Interface 
 

3.1  Open files 
 
After starting WinPHOTON, users should open the file which contains the results of 

the calculation.  Its default name is PHI; but other, 4-character, names may be used.  

Alternatively, users can open a so-called USE file containing the commands PHI or 

EXTRAPOLATION, which also serve to open data files. 

 
3.1.1 Open PHI file 

To open the file, users can select menu item File->Open PHI/XYZ file.  The dialog 
window Open PHI/XYZ file will be opened.  The window is shown in Figure 3.1. 

 

 
Figure 3.1 
 
Users can select a file from any directory on the hard drive via the Browse button 

near the input field PHI-name.   
 
If necessary users can change scales on axes X, Y and Z. 
 
It a case has been run with a body-fitted-co-ordinate (BFC) grid, it is necessary to 

open file XYZ as well as file PHI.  File XYZ saves geometry data about curvilinear grids. 

 

XYZ can be given another name. 

 
If users check box Use Extrapolate, two control volumes will be added to all 

boundaries of the calculation area which allows the creation of objects (CONTOURS, 
VECTORS, etc) on the whole surface of the calculation area and not only on internal centres 
of control volumes.   NOTE: if Use Extrapolate is chosen, the number of control volumes will 
be increased by two in each direction.  

 
Command sequences will be generated and executed by using the OK button.  These 

commands will open files and set scales. 
 
3.1.2 Open USE file 

Users can prepare and execute a ‘macro’ file containing a set of commands (the so-
called USE file).  For this purpose, users should select menu item File->Open Photon Use 
file. A dialog window Open Use file will be opened as shown in Figure 3.2. 
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Figure 3.2 
 
Users can search for files on the hard drive via the Browse button.  To create a new 

file, or edit an existing file, use the Edit button; the program notepad.exe will be started and 
WinPHOTON will be blocked.  Users can change the USE file and save the changed variant.  
Once users exit from notepad.exe, WinPHOTON will continue.  WARNING: if users save 
changes into a new file, it must be selected by the Browse button before pressing OK. 

 
After pressing OK, USE mode starts command-by-command. Once USE mode has 

started, the following command is generated: 
USE <directory>\<use-file> 

 

Users can cancel USE mode via the BREAK command in Console Command. 

 
3.1.3 Open file PATGEO 

Sometimes users need to see the geometry of objects. For this purpose, file patgeo 

must be opened using menu item File->Open Patgeo file.  Dialog window Open PATGEO file 
will open as shown in Figure 3.3. 

 

 
Figure 3.3 
 
Working in this window has the same functionality as working in the Open Use file 

described in 3.1.2.  The OK button generates the command 
USE <directory>\patgeo 

 

3.2  Drawing operations 
 

Before drawing objects, users should open file PHI or file XYZ. 

 
The interface for creating drawing objects contains two dialog windows: the first lists 

objects and the second contains the interface for changing object parameters.  
 

3.2.1 Drawing Grids 
To create a GRID drawing element, users should select menu item Draw->Grids.  The 

window Grid Objects containing a list of existing objects will open as shown in Figure 3.4. 
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Figure 3.4 
 
The window contains an object list from which users can:  

 select any object and use edit (via the Edit button),  

 change its visibility (ON/OFF button),  

 move it up or down (UP and DOWN buttons) and  

 delete (Delete button).  
 
The order in which the objects are described is the order in which they are drawn on 

the screen.  Users can change this order via the UP and DOWN buttons, which may be 
important when drawing contour planes which can hide previous drawings.  Users can delete 
all objects by using the Delete All button 

 
There are ReDraw and Close buttons at the bottom of window.  ReDraw executes the 

REDRAW command which redraws all active drawing objects on screen.  This is useful when 

users have edited objects and want to see the change without closing the window.  Close 

closes the window and generates the command REDRAW. 

 
To create new objects, users can use the Add button.  Window Grid Command will  

open as shown in Figure 3.5 
 

 
Figure 3.5 
 

This window controls the extent of the grid drawn on the screen.  In the above 
example, the grid is plotted in the first x plane.  The grid will be drawn in solid red lines 
outlining the cell.  Users may set attributes for the object: colour and type of line etc.  For 
Multi-Block cases the block number must also be set. 

 

The Save button generates the command GRID or MGRID for multi-block model), for 

example: GRID CENT Z   1 X   1  18 Y   1  18 COL   1 DASH 0 

 
Objects are plotted in the main window and added to the list in window Grid Objects. 

   
  If users want to change object parameters, this must be done via the Edit button in 
window Grid Objects and in the Grid Command window. 
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3.2.2 Contour Drawing 
To create a CONTOUR drawing element, users should select menu item Draw-> 

Contour. The window CONTOUR Objects containing a list of objects opens as shown in 
Figure 3.6. 

 

 
Figure 3.6 
 
The window contains a list of objects.  Users can select any one and undertake any of 

the following actions:  

 edit (via the Edit button),  

 change visibility (ON/OFF button),  

 move up or down in the list (UP and DOWN buttons),  

 delete (Delete button).   
 

Changing the position in the list changes the order of plotting on screen so that the 
object list corresponds to the drawing order on screen.  Users can delete all objects by using 
the Delete All button 

 
There are ReDraw and Close buttons at the bottom of window.  ReDraw executes  

REDRAW, a command which redraws all active drawing objects on screen.  This is useful 

when users have edited objects and want to see the change without closing the window.  

Close closes the window and generates the command REDRAW. 

 
To create a new object, users use the Add button.  Window CONTOUR Command 

will be opened as shown in Figure 3.7 
 

 
Figure 3.7 
 

Using this window, users can set object parameters:  

 numbers of first and last control volumes in a direction perpendicular to selected 
plane; 

 direction of normal to plane of object being created; 

 number of planes.   
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Users may choose to colour-fill the contour regions or draw isolines at contour 
intervals.  If users select colour filling, the Fineness parameter can be set.  If this value is 
small, the drawing time can be long.  Conversely, if the value is large the drawing is done 
quickly, but image quality may be poor. 

  
If users decide to draw using isolines, the number and type of isolines must be set. If 

Shade is not checked, a selected colour will be used for drawing; otherwise isolines will have 
various colours. Users can also set the type of isoline (Solid or Dash). 

 

Users can set the number of blocks for object creation for a multi-block model. 
 

If users wish to restrict the range of variable values for object creation this can be 
done by using the box Is Range to set maximum and minimum values of variable. 

 

If PARSOL is used in calculations and Parsol Boundaries is checked, a new variable 
*PSC will be created which mark the boundaries of cut-cells and enables them to be seen.  

 

In some cases, for example to create contours for variables PRPS or RHO, it is 
acceptable to see “non-smooth” contours. Users can use No Smooth Fill; then the image will 
lack smoothing and each control volume will have its own single colour. 

 

Save generates command CONTOUR (or MCONTOUR for multi-block model), for 

example: 
CONTOUR P1 Y   9 X   1  18 Z   1  31 FILL; -8.00E+00  4.00E+00 ;  8.00E-04 
 
The object will be plotted in the main window and added to the list in window 

CONTOUR Objects. 
 

If users want to change object parameters, this must be done via the Edit button in 
window CONTOUR Objects and in the CONTOUR Command window. 

 
3.2.3 Vector Drawing 

To create a VECTOR drawing element, select menu item Draw-> Vector.  The 
window VECTOR Objects, containing a list of objects, will open as shown in Figure 3.8. 

 

 
Figure 3.8 
 

Users can select any object from those listed and: 

 edit (Edit button),  

 change visibility (ON/OFF button),  

 move up or down in list (UP and DOWN buttons),  

 delete (Delete button).   
 
The object list corresponds to the drawing order on screen.  Users can delete all 

objects by using the Delete All button 
 
There are ReDraw and Close buttons at the bottom of window.  ReDraw executes the 

REDRAW, command which redraws all active drawing objects on screen.  This is useful when 
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users have edited objects and want to see the change without closing the window.  Close 

closes the window and generates the command REDRAW. 

 
The Add button opens window VECTOR Command (Figure 3.9) to create a new 

object. 
 

 
Figure 3.9 
 
 

Users can set object parameters via this window:  

 numbers of first and last control volumes in a direction perpendicular to selected 
plane; 

 direction of normal to plane of object being created; 

 number of planes.   
 
Users can also set object attributes:  

 names of variables for components of velocity,  

 relative length of vector,  

 method of forming the colour of lines,  

 type of line and so on.   
If the calculation is made for a multi-block model, users must set the number of blocks 

for creating the object. 
 
The Save button generates a set of commands, for example: 
SET VEC COMP U1 V1 W1 

SET VEC CENTRE OFF 

SET VEC KEY ON 

SET VEC REFERENCE 3.08397 

VECT Z   1 X   1  18 Y   1  18  SH DASH 0 

 
This presets object parameters and creation.  The object will be plotted in the main 

window and the new object will appear in the object list in window VECTOR Objects. 
 
Users can change object parameters via the Edit button in window VECTOR Objects 

and in the VECTOR Command window. 
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3.2.4 Surface Drawing 
To create a SURFACE drawing element, users select menu item Draw-> Surface. 

The window SURFACE Objects containing a list of objects opens as shown in Figure 3.10. 
 

 
Figure 3.10 
 

Users can select any object from the list shown and:  

 edit (Edit button),  

 change visibility (ON/OFF button),  

 move up or down in list (UP and DOWN buttons),  

 delete (Delete button).   
 

The object list corresponds to the drawing order on screen.  Users can delete all 
objects by using the Delete All button 

 
There are ReDraw and Close buttons at the bottom of window.  ReDraw executes the 

REDRAW, command which redraws all active drawing objects on screen.  This is useful when 

users have edited objects and want to see the change without closing the window.  Close 

closes the window and generates the command REDRAW. 

 
New objects are created via the Add button.  Window SURFACE Command will open 

as shown in Figure 3.11. 
 

 
Figure 3.11 
 
Using this window, users can set object parameters:  

 variable for object creation,  

 value of variable,  

 plane,  

 colour and type of lines. 
 

The Save button generates command SURFACE, for example: 
SURFACE P1 Z  COL   1 DASH 0 -2.48E+00 

The object will be plotted on the main window and the new object will appear in the 
object list in window SURFACE Objects. 

 
Users can change object parameters via the Edit button in window SURFACE 

Objects and in window SURFACE Command. 
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3.2.5 Stream-Line Drawing 
To create a STREAMLINE drawing element, select menu item Draw-> StreamLines. 

The window STREAMLINES Objects containing an object list opens as shown in Figure 3.12. 
 

 
Figure 3.12 
 

Users can select any object from the list shown and: 

 edit (Edit button),  

 change visibility (ON/OFF button),  

 move up or down in list (UP and DOWN buttons),  

 delete (Delete button).   
 
The object list corresponds to the drawing order on screen.  Users can delete all 

objects by using the Delete All button. 
 
There are ReDraw and Close buttons at the bottom of window.  ReDraw executes the 

REDRAW command which redraws all active drawing objects on screen.  This is useful when 

users have edited objects and want to see the change without closing the window.  Close 

shuts the window and generates the command REDRAW. 

 
A new object is created via the Add button; and the STREAMLINES Command 

window will open as shown in Figure 3.13. 
 

 
Figure 3.13 
 

Using this window, users can set object parameters, initial conditions, determine 
trajectories of test particles moving with flow and numerical parameters for calculation of 
trajectories. Object parameters are similar to other drawing elements:  

 numbers of first and last control volumes in a direction perpendicular to selected 
plane; 

 direction of normal to plane of object being created; 

 number of planes.   

 Users can set object attributes: colour, type of line etc. 
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Users can set the number of trajectories for: 

 calculation,  

 calculation method:  

 whole field,  

 downward or upward.  
 
It is necessary to set numeric parameters:  

 time step,  

 number.  
 
Initial conditions can be set: 

 from an initial point along line determined from start point to end point,  

 from points on circle  

 from the start point.   
 
The Add button starts calculating trajectories of test particles, for example: 
STREAM 3D Z   1 X   1  18 Y   1  18  SH DASH 0 

YES 

WHOLEFIELD 

STEPS;  100 

TIME;1.000E+00 

PO 

-1 

    1    1 

   18   18 

   10 

T 

EXIT 

   10 

 
Calculations begin from the start of a line of points and continue to the domain exit. If  

trajectories cannot exit the domain, because of flow features, and calculations are too 
lengthy, users can terminate calculations via the Break of Drawing button.  The calculation 
will terminate but an object will be created as part of trajectory calculated to time of 
termination.  The object will be plotted in the main window and will appear in the object list in 
window STREAMLINE Objects.  Unlike other object types, STREAMLINE objects cannot be 
edited. Users can delete and re-create with other parameters. 

 
3.2.6 Text Element Drawing 

To create a TEXT drawing element, select menu item Draw-> Text; then the window 
List of text elements (containing a list of objects) opens as shown in Figure 3.14. 

 

 
Figure 3.14 
 
Users can select any object from the list shown and edit (Edit button), delete (Delete 

button) or delete all objects (Delete All button). 
 

The Close button shuts the window and generates the command REDRAW. 
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New objects are created via the Add button.  Window Add and Edit Text Element 
opens as shown in Figure 3.15. 

 

 
Figure 3.15 
 
Using this window, users can:  

 set object parameters,  

 enter text,  

 set the font of text,  

 select text colour from box Colours (not from standard window of font parameters).   
 
WINPHOTON always draws TEXT objects on the main window therefore users can 

see all changes and move text on screen using arrows. 
 
The ОК button does not generate commands but the object will be plotted in the main 

window and will appear in the object list in window List of text elements. 
 
Object parameters can be changed via the Edit button in the window List of text 

elements. When object parameters are changed, users can see images of the object, both 
saved and changed, in the main window  

 
3.3  Settings 

 
Users can change most parameter settings of WinPHOTON by entering commands 

SET in the Command Console window. For some commands, dialog windows are available.  

 
3.3.1 View Direction 

Users may wish to change view direction and view point, to use zoom, to change 
direction UP etc.  To set the view point select menu item View->View Direction.  The window 
View dialog opens and, at this point, WinPHOTON changes to special drawing mode so that, 
in the main window, users see only domain boundaries and GRID objects.  Figure 3.16 
shows the main window and Figure 3.17 the View dialog window. 

  

 
Figure 3.16 
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Figure 3.17 
 

Axes can be seen in the main window: 

 X – blue line,  

 Y – green line,  

 Z – red line.  
 
Users can change the UP direction by selecting one of three axes on the left of the 

window, changing the angles of the view direction relative to the axes and moving the 
scrolling Azimuth and/or Elevation by using arrows in area Move.  If users check Mirror then, 
after the dialog window is closed, mirror images are created relative to selected directions. 
Users can zoom by using UP and DOWN arrows near field Zoom.  Users can edit Zoom, but 
the size will change only after pressing on arrows. 

 
If users calculate using the multi-block model, Show Block will show the geometry of 

each block separately by changing the block number.  The geometry of all blocks may be 
seen if the number of blocks is set to zero.  

 

To reset previous view direction and other parameters, use the Reset button 
 

The OK button generates a set of commands to save changes, for example: 
VIEW   7.28E-01   5.77E-01  -3.71E-01 

UP   0.00E+00   1.00E+00   0.00E+00 

MIRROR X 

REDRAW 

The final command is generated when it is necessary to redraw all objects.  
 

3.3.2 Setting Parameters 
WinPHOTON uses many parameters when drawing objects.  Users can change 

parameters via command SET <parameter> [1].  For some changes users can select menu 

item Setting->Set params and window SET commands opens as shown in Figure 3.18. 
 

 
Figure 3.18 
 

Use of the OK button ensures that only necessary commands will be generated 
connected to User changes. For example: 

SET CON FILL NUMBER 

SET AXES OFF 

SET LHAND 
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3.3.3 Setting Colours 
Menu item Setting->Set Colours changes the colours of the main elements in the 

main window; the Colours window opens as shown in Figure 3.19. 
 

 
Figure 3.19 
 
Users can change the following colours:  

 background of drawing area,  

 background of outside area,  

 lines  

 default text  
by selecting colour from a preset palette. 
 
Users can set the number of colours for drawing CONTOURS and VECTORS.  If the 

standard 16-colour palette is selected via 16 Colours, CONTOUR colours will have clear-cut 
boundaries.  Users can set an arbitrary number of colours in range from 16 to 256 by 
unchecking 16 Colours and setting the needed number of colours. There will be no 
qualitative change to the colour palette; but the CONTOUR images will be smoother.  

 

Values of selected colours will be saved in file phoenics/d_allpro/coldat via 

the OK button.  The REDRAW command will be generated; and, when WinPHOTON restarts, 

all colours set by users will be restored. 
 

3.3.4 Setting Plotting Order 
Users may need to change the drawing order for various types of objects. This can be 

done via menu item Setting->Plotting order. The window Plotting order opens as shown in 
Figure 3.20. 

 

 
Figure 3.20 
 

Users can select the order of drawing objects via UP and DOWN buttons 
 
When WinPHOTON terminates, the order of drawn objects is not saved; therefore 

users should set the drawing order of objects at the start of the program. 
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3.4  Macro Variables and Field Variables 
 
WinPHOTON users have the possibility of recording a set of commands in USE files 

(see 3.1.2).  When preparing USE files, it is necessary to create new variables to save useful 
information. These are called macro-variables and can have numerical values (integer or 
real); or they can be string variables (up to 80 characters).  During the processing of USE 
files their current values will be used. 

 
WinPHOTON users can change the number of variables by adding new field 

variables and deleting calculated ones.  For example, if users calculate hydrodynamic flow, 
and wish to calculate local values of kinetic energy of flow, new variables can be added and 
calculated via pre-set formulae. Users can include in formulae:  

 calculated field variables,  

 macro-variables,  

 internal functions,  

 arithmetic operations  

 constants.   
All variables can have an image created. 
 
When working with macro-variables and field variables, users can use two internal 

constants: 
PI = 3,141593 

E  = 2,718282 

users should adhere to the following rules in formulae: 

 use pair parenthesis "2.*(3.+4.)";  

 use operation "*", "/", "+", "-" and "^" for power;  

 use the next functions: 'ATAN', 'COS', 'SIN', 'TAN', 'ABS','EXP', 'LN', 'LOG', 
'SQRT'(square root), 'SQR' (square), 'INT'(rounding-off), 'FRAC' (remainder = Arg- 
REAL(INT(Arg)), 'TRUNC'(integer part), 'ASIN', 'ACOS', 'SIGN'(sign of argument);  

 use less than 80 characters for commands;  

 use parenthesis for power operation after multiplication or division;  

 multiply by (-1) to change the sign of argument;  
 

3.4.1 Macro Variables 
Users must use new commands of WinPHOTON for work with macro-variables: 
  MACro INTeger <list of variables> 

  MACro REAL <list of variables> 

  MACro CHAR <list of variables> 

Users can use assignment operation for macro-variable, for example: 
  Macro Integer N 

  Macro real R 

  Mac char S 

  N = :NX: + :NY: + :NZ: 

  R = PI/3.0 

  S = A:N:.dat 

 
Macro-variables NX, NY and NZ are determined by the results of calculations.  As a 

result of execution, the set of command the string S depend on amount of control volumes of 
all directions.???  Users can use macro-variables with other WinPHOTON commands, for 
example: 

  Macro real FI 

  FI = 1.e-4 

  con TEMP iy M fi;:FI: 
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The following commands were created to work with macro-variables: 

  Macro CLEar  - to delete all macro-variables (besides NX, NY, NZ); 

  MACro DELete <list of variables> - to delete macro-variables from list; 

  MACro RECalc – to recalculate all macro-variable. 

 
To work with macro-variables, users select menu item Variables-> Macro Variables. 

The window Macro Variables opens as shown in Figure 3.21. 
 

 
Figure 3.21 
 

Users can select from the list and:  

 edit formula-determined macro-variables (Edit button),   

 delete any macro-variable (Delete button),  

 delete all macro-variables (Clear button),  

 recalculate all macro-variable (ReCalc button).   
 
New macro-variables can be created via the Add button. The Macro Variables 

window will open as shown in Figure 3.22. 
 

 
Figure 3.22 
 

Users can enter: 

 a unique name for a new macro-variable,  

 formula for its determination,  

 select the type of macro-variable,  

 use the Add button.   
 
If a mistake occurs, a message will appear in the Command Console.   
 
The Macro Variables window can be closed only by pressing the Close button; users 

will see all created macro-variables listed, with their values. 
 

3.4.2 Field Variables 
To work with new field variables, users can use the WinPHOTON command: 
ADDVAR <name of variable> is <formula> 
For example 
ADDVAR EX is U1^2 
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In dialog mode, users select menu item Variables-> PHI Variables and the PHI 
Variables window opens as shown in Figure 3.23. 

 

 
Figure 3.23 
 

With field variables, users can carry out the following operations:  

 add new variable (button Add),  

 edit formulas for variables,  

 delete variables as created by users or calculated by solver Earth. 
 
New variables can be created via the Add button and the PHI Variables window will 

open as shown in Figure 3.24. 
 

 
Figure 3.24 
 

Users can enter a unique name for a new field variable and a formula for its 
determination. The formula can contain identifiers of other field variables (created by users or 
calculated by Earth), macro-variables, pre-defined variables X, Y and Z, denoted coordinates 
and constants.  

 
If an error occurs, a message appears in the Command Console.  The PHI Variables 

window can be closed via the Close button; users will see all created macro-variables listed 
with their values. 

 
3.4.3 Inspect PHI Variables 

WinPHOTON is intended to display results graphically; however it can also enable 
users to inspect numerical values.  

 
To do so, users select menu item Variables-> Look of Variable; then the Select 

Variables window opens as shown in Figure 3.25. 

 
Figure 3.25 
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After selecting the variable users should press OK. The window Variable: <name of 
variable>  opens as shown in Figure 3.26. 

 

 
Figure 3.26 
 

Users can select a plane (direction of normal and number) to view values of variables; 
and they can change step values plotted in the table on screen.  Users can also change the 
font and format of values using icons on the top panel.  To close the window, users press the 
green tick. 

 
3.5      Transient cases 
 

WinPHOTON makes it possible to view calculation results for transient cases.  When 

non-stationary processes are calculated, sets of files named <prefix>No are usually 

created, where <prefix> - characters, No –number of file. 

 
Users can create USE-file, containing sets of commands for drawing images on one 

time step. This can be done very simply by:  

 opening a file of a non-stationary processes,  

 creating the necessary set of objects,  

 selecting menu item Draw-> Save of drawing commands.   
 
A standard systems window to allow file selection will open.  The USE-file will contain 

commands set view direction, UP direction and commands for creation of objects GRIDS, 
CONTOURS, VECTORS, SURFACES.  It is possible to save images; this is useful in cases 
where it is necessary to build similar images for similar calculation results. After the USE-file 
is created, it is possible to demonstrate the non-stationary process. 

 
Users can use a WinPHOTON command: 

 TRANSience <prefix> NoBeg NoEnd NoStep <USE_file> trWait 

[<Work  Directory>] where TRANSience – name of command; 

 NoBeg NoEnd NoStep –  number of first file, number of last file and step of file 

number accordingly;  

 <USE_file> -    name of USE-file without path; 

 trWait –      delay time in milliseconds, if trWait = -1 then 

animation will be stopped after each frame and users could press RUN in the 
Command Console window; 

 [<Work Directory>] –  directory with files of calculation results and USE-file, 

if a directory is not set, WinPHOTON will use the current directory. 
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In animation mode, users can interrupt drawing via the ESCAPE key.  In other cases 
users can enter character “/” in window Command Console and press Run. 

 
Users can also select the Draw-> Transience command and window Transience 

command opens as shown in Figure 3.27. 
 

 
Figure 3.27 
 

Users can select a working directory. The best way is via Browse, selecting the last 
file of the calculation of the non-stationary process.  Some fields in the window will be 
entered automatically (prefix of PHI-files, First number, Last number and Step).  Users can 
then select the created USE-file, check Animate and set the duration of the pause in 
milliseconds. If Animate is unchecked then the mode “frame-by-frame” will be selected. 

 

The command TRANSience will be generated after pressing OK, for example 
 TRANS M    1  20   1 trans.use      200 

  C:\phoeclos\ToReport\Brokntip\ 

 
In animation mode, the Command Console window will be hidden. The execution of 

command TRANSience executes the USE-file commands sequentially for each file of 

calculation results. 



The PHOTON User Guide 

28 The PHOTON User Guide 

4.  AUTOPLOT Interface 
 

AUTOPLOT is a part of WINPHOTON designed to produce labelled plots of 
numerical data in the form of graphs showing the variation of variables one against another. 

 
To use AUTOPLOT select menu Run->Autoplot  which will change the main menu.  

As with PHOTON, users can work in the Command Console window and, when AUTOPLOT 
is run, it will store the commands entered during the session in a file.  The file is written in 
USE-file format, which can be read by AUTOPLOT to recreate the session at a later time.  
Users can also use dialog windows which give wider possibilities than standard command 
mode. 

 
4.1  Opening Files 

Users should open one, or several, data files when starting AUTOPLOT. 
 

4.1.1 Open Data Files 
To open files containing data, select menu item File->Data Files and window Opened 

Files will open as shown in Figure 4.1. 
 

 
Figure 4.1 
 
Users can add a data-file, delete one data-file or delete all files simultaneously.  New 

data files can be added via the Add button and the Open File window will open as shown in 
Figure 4.2. 

 

 
Figure 4.2 
 
Users can select files via Browse and set the file type.  Detailed information about 

types of data-files can be found in [2].  The Add button closes Open File and the selected file 
will appear in a list of files in Opened Files. 

 
AUTOPLOT generates sets of commands, for example: 
File 

C:\phoeclos\ToReport\Brokntip\M6 5 
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4.1.2 Open Use Files 
AUTOPLOT handles USE-file in the same way as WinPHOTON.  To use this feature 

users must create a USE-file containing AUTOPLOT commands and select menu item File-
>Open Use File.  Working in AUTOPLOT, via the Open Use File window as shown in Figure 
4.3, is fully analogous to working with the same window of WinPHOTON.  A detailed 
description is to be found in 3.2.1 

 

 
Figure 4.3 
 

4.2  Data for Plotting 
 
Graphics are created via a series of data using Command->Datas.  This opens the 

Data Elements window as shown in Figure 4.4. 
 

 
Figure 4.4 
 
Users can select any object from those listed and add or edit data (Add or Edit 

buttons), change visibility (ON/OFF button), save the series to a separate file (Save button); 
and delete one series or all series (Delete or Delete All buttons).  Users can create new 
series and enter data in separate windows via the New button.  Data series created by this 
method cannot be edited later so users must delete and recreate any such series. 

 
To add new data series from an open file use the Add button which opens the Adding 

Data Element window as shown in Figure 4.5. 
 

 
Figure 4.5 
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Users can select data files.  For various types of files controls can be enabled or 

disabled.  For the PHI file, users select variable names, abscissa directions, the number of 

first and last points in the series and set colour and line type.  
 
Command sets will be generated using the Plot button, for example: 
DATA  1 

P1 Z   1 Y   1  50 

SCALE 

BLB2  1 

 
To create a new data series without connecting to an open file, users press button 

New in the Data Elements window. The window New data set opens as shown in Figure 4.6. 
 

 
Figure 4.6 
 
Users can enter data in windows X and Y, form data series and use: 

 Add to add these data to the end of series,  

 Insert to insert before selected line,  

 Replace to replace selected line  

 Delete to delete selected line.  
 

Data in series should be ordered by increasing X.  Users must check entered data 
because, after pressing the Plot button, data cannot be changed.  Command sets will be 
generated after pressing on button Plot: 

SCALE 

REDRAW 

 
4.3      Add-on elements 

 
Users can create add-on graphical elements for better performance. The following 

objects relate to this:  TEXTS, KEYS и LEVELS. 
 

4.3.1 Text and key elements 
To create objects TEXTS and KEYS users can select menu item Command->Texts. 

The window List of text elements opens as shown in Figure 4.7. 
 

 
Figure 4.7 
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Users can use buttons Add and Edit to add or edit objects; buttons Delete and Delete 
All to delete selected object or all objects; and button Close to close window.   Buttons Add 
or Edit open windows Add and Edit of Text elements and select Keys as shown in Figure 4.8. 

 

 
Figure 4.8 
 
Using this window users can set parameters of object: enter text, set the font of text, 

select colour of text from combo box Colours (not from standard window of font parameters). 
The AUTOPLOT as WINPHOTON draws TEXT object always on main window therefore 
users can see always all changes. Users can move text on screen using arrows. 

 
If users want to create KEY objects together with TEXT objects then the With Key box 

should be checked and DATA object for KEY element selected.  Users can replace the KEY 
object relative to  TEXT using arrows, change length of object KEY and amount of points for 
drawing of KEY.  ???? 

 
After pressing the OK button all entered information will be saved and command 

REDRAW will be generated to redraw the image on the screen. 

 
4.3.2 Levels 

If users may want to mark the defined level on axes abscissa or ordinate.  This can 
be done by create object LEVEL.  Users select menu item Command->Levels and the Levels 
window will be opened as in Figure 4.9. 

 

 
Figure 4.9 
 
Users can use Add and Edit to add or to edit objects, Delete and Delete All to delete 

selected object or all object accordingly, and Close to close windows.  The Add or Edit 
buttons open the Edit Level window as shown in Figure 4.10. 
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Figure 4.10 
 
Users can set level direction, value of axes for level, colour of level. The LEVEL 

object is created by the OK button and drawn on main window. 
 

4.4      Settings 
 
  Users can change most AUTOPLOT parameters using commands in window 
Command Console. Some of command users can send using dialog windows. 

 
4.4.1 Set colours 

Users can change the colours of general elements in the main window via menu item 
Setting->Set Colours.  The Colours window opens as shown in Figure 4.11. 

 

 
Figure 4.11 
 
Users can change colours of background, lines, axes, grids and levels set by default. 
 

4.4.2 Set keep parameters 
Sometimes users want to delete all graphics except add-ons, for example, TEXTS 

objects.  This can be done via the KEEP command or by selecting menu item Setting->Keep 

parameters which opend the Keep window as shown in Figure 4.12. 
 

 
Figure 4.12 
 
Users must check the check boxes to keep needed objects and then press OK.  A set 

of AUTOPLOT commands will be executed, for example: 
TEXT KEEP 

KEY KEEP 
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4.4.3 Set scale 

If users want to change scales of axes on graphic this can be done via menu item 
Setting->Scale which opens the Scale window as shown in Figure 4.13. 

 

 
Figure 4.13 
 
If the All axes box is checked and OK is pressed, then the SCALE command will be 

executed and scales will be recalculated automatically. 
 
If users want to set scale on axes manually then the All axes should be unchecked 

and the  direction of axes on which the scale is to be changed should be entered.  Maximum 
and minimum values for these axes should be specified and the OK button pressed.  A set of 
commands will be generated, for example: 

SCALE X 
  0.000E+00  6.000E+00 
 

4.4.4 Set grids 
If users want to draw grids on graphics, this can be done via menu item Setting-> 

Grid. The window Grid will be opened as shown in Figure 4.14. 
 

 
Figure 4.14 
 
If users check the Automatic (On/Off) box and press OK then command GRID will be 

executed and a grid will be created automatically. 
 
If users want to set the grid manually, it is necessary to uncheck the Automatic 

(On/Off) box, set values of grid step on each direction and press OK.  A command of the 
following type will be generated: 

GRID DEFINE  1.000E+00  1.000E+01 
 


